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Paper Set 1 · 18 Jun 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
A cistern has two pipes, Pipe A and Pipe B. Pipe A can fill the cistern
in 6 hours, while Pipe B can fill it in 8 hours. A third pipe, Pipe C, is
an outlet pipe that can empty the full cistern in 12 hours. If all three
pipes are opened together, how long will it take to fill the cistern
completely?

A.  A. 4.5 hours

B.  C. 4.8 hours

C.  B. 5.2 hours

D.  D. 5.8 hours

✓

Q2 Quant
A shopkeeper sells an item for ₹2,988 and incurs a loss of 17%. What
was the cost price of the item (in ₹)?

A.  D. 2,555

B.  A. 3,500

C.  B. 3,600

D.  C. 3,700

✓

Q3 Quant
A, B and C start a business. A invests ₹60,000 for 12 months. B
invests ₹45,000 for 12 months. C joins after 4 months with ₹30,000
and stays till year end. If the total profit at the end of the year is
₹125,000, find C’s share.

A.  ₹10,000

B.  ₹15,000

C.  ₹20,000

D.  ₹25,000

✓

Q4 Quant
The amount ₹644 is divided among X, Y and Z in such a manner that
X : Y is 3 : 7 and Y : Z is 5 : 6. What is X’s share?

A.  B. ₹105

B.  D. ₹214

C.  C. ₹193

D.  A. ₹161

✓

Q5 Quant
A train travels 132 km, the first 60 km at a certain speed and the
remaining distance at a speed of 8 km/hr more than its previous
speed. If it takes 3 hours for the train to complete the journey, find
the speed (in km/hr) in the first part of the journey.

A.  A. 38

B.  D. 40

C.  C. 42

D.  B. 45

✓

Q6 Quant
There are 1020 students in a school, of which 600 are girls. What is
the ratio of the number of boys to that of girls in the school?

A.  D. 5 : 7

B.  C. 10 : 9

C.  A. 7 : 10

D.  B. 11 : 15

✓

Q7 Quant
Find the median of the following data.
Class interval 0-8 8-16 16-24 24-32 32-40
Frequency 4 6 8 5 7

A.  D. 17

B.  C. 19

C.  B. 21

D.  A. 23

✓

Q8 Quant
If the ratio of two numbers is 9 : 5, and their HCF is 6, then their LCM
is:

A.  C. 270

B.  D. 311

C.  B. 288

D.  A. 301
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✓

Q9 Quant
Amit invested equal amounts at simple interest and compound
interest (compounded annually) for 2 years at the same rate of 8%
per annum. At the end of the period, the difference between the
interests earned was ₹96. What was the amount (in ₹) invested in
each case?

A.  D. 15,000

B.  A. 12,000

C.  C. 16,000

D.  B. 18,000

✓

Q10 Quant
Which of the following is true for triangles?
(a) The sum of two sides is equal to the third side.
(b) Two interior angles can be right angles.
(c) The angle opposite to the longest side is the greatest.
(d) All interior angles cannot be acute angles.

A.  C. (a)

B.  A. (b)

C.  D. (c)

D.  B. (d)

✓

Q11 Quant
The total surface area of a cube with side 28 cm is:2678

A.  A. 4704 cm2

B.  D. 4664 cm2

C.  B. 4780 cm2

D.  C. 4610 cm2

✓

Q12 Quant
A number is first decreased by 25% and then increased by 20%. The
number so obtained is 356 less than then the original number. What
is 40% of the original number?

A.  A. 1244

B.  C. 1224

C.  B. 1424

D.  D. 1422

✓

Q13 Quant
The price of a stock decreased by 8% one week and increased by
20% in the following week. If the initial price of the stock was
₹48,000, find the final price of the stock after these two weeks.

A.  D. ₹52,792

B.  B. ₹52,992

C.  A. ₹52,469

D.  C. ₹52,575

✓

Q14 Quant
A dealer sells two washing machines at the rate of ₹87000 per
washing machine. On one he earns a profit of 20% and on the other
he loses 40%. What is his loss percentage in the whole transaction?
1708

A.  A. 20%

B.  C. 19%

C.  D. 22%

D.  B. 18%

✓

Q15 Quant
A person travels 60 km by car at a speed of 40 km/h and then covers
the next 40 km by bus at a speed of 60 km/h. What is the average
speed (rounded off to two decimal places) of the person for the
entire trip?

A.  D. 46.15 km/h

B.  C. 49.25 km/h

C.  A. 41.52 km/h

D.  B. 44.53 km/h

✓

Q16 Quant
A can complete a piece of work in 72 hours; B and C together can
complete it in 48 hours, while A and C together can complete it in 36
hours. How long (in hours) will B alone take to complete the work?

A.  A. 144

B.  C. 143

C.  B. 145

D.  D. 146

✓

Q17 Quant
The average of the first 17 multiples of 3 is:

A.  A. 27

B.  C. 3

C.  D. 17

D.  B. 25.5
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✓

Q18 Quant

Find the roots of the quadratic equation 2x2 + 5x + 3 = 0.

A.  

B.  

C.  

D.  

✓

Q19 Quant
A solid cone has a radius of 21 cm. The slant height of the cone is 28 cm. The cone is hollowed out such that the hollow part is a smaller cone
similar to the original cone with its radius half of the original radius. Find the curved surface area of the remaining solid.

A.  

B.  

C.  

D.  

✓

Q20 Quant

A.  B. 70.345

B.  D. 71.865

C.  C. 72.752

D.  A. 73.644

GA

✓

Q21 GA
Where is the Gorumahisani Iron Ore Mine located in India?

A.  A. Keonjhar district, Odisha

B.  D. Sundergarh district, Odisha

C.  B. Mayurbhanj district, Odisha

D.  C. Koraput district, Odisha

✓

Q22 GA
The Revolt of 1857 was famously called the 'First War of Indian
Independence' by which of the following National leaders?

A.  B. Bal Gangadhar Tilak

B.  D. V.D. Savarkar

C.  C. Subhas Chandra Bose

D.  A. Mahatma Gandhi

✓

Q23 GA
In March 2025, which of the following won the 12th Shambhavi
Puraskar, instituted by the Bansidhar and Ila Panda Foundation in
Odisha, for its contribution to society?

A.  C. Centre for Integrated Rural and Tribal Development

B.  D. Organisation For Rural Reconstruction and Social Service
Action

C.  A. Natural Institute for Social Welfare

D.  B. Association For Minority Access Research
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✓

Q24 GA
Which early 20th-century organisation is widely credited with
leading the Odia linguistic and cultural unification movement that
ultimately contributed to the creation of a separate province of
Odisha in 1936?

A.  C. Servants of India Society

B.  A. Utkal Sammilani

C.  B. Arya Samaj, Cuttack branch

D.  D. Indian National Social Conference

✓

Q25 GA
In which part of the Indian Constitution are the Directive Principles
of State Policy, which guide the government in creating a welfare
state with social and economic justice, included?

A.  A. Part II

B.  D. Part IV

C.  B. Part VII

D.  C. Part IX

✓

Q26 GA

According to reports published in September 2025, Debrigarh
Wildlife Sanctuary was proposed to become which national park of
Odisha in terms of order of establishment?

A.  A. First

B.  D. Second

C.  B. Third

D.  C. Fourth

✓

Q27 GA
Which of the following guarantees 100 days of employment in a
financial year to any rural household in India whose adult members
volunteer to do unskilled manual work?

A.  B. Mahatma Gandhi National Rural Employment Guarantee
Act

B.  A. Deendayal Antyodaya Yojana – National Rural Livelihood
Mission

C.  D. Labour Welfare Fund Act, 1965

D.  C. 73rd Amendment of Panchayati Raj in India

✓

Q28 GA
As announced in November 2025, which key benefit do the new
Labour Codes provide to women in the workplace?

A.  B. Unlimited leave for personal reasons

B.  C. Retirement benefits above 60 years

C.  D. Maternity leave up to 26 weeks

D.  A. Mandatory foreign training opportunities

✓

Q29 GA
Which country clinched the Billie Jean King Cup title in 2025?

A.  B. United States of America

B.  D. Czech Republic

C.  C. Australia

D.  A. Italy

✓

Q30 GA
Which Indian shooter won a gold medal in the women’s 10 m air
pistol event at ISSF World Cup Rifle/Pistol 2025 held in Ningbo
during 7th to 15th September 2025?

A.  C. Esha Singh

B.  D. Manu Bhaker

C.  A. Elavenil Valarivan

D.  B. Suruchi Singh

✓

Q31 GA
Which of the following statements best explains the role of the
Aravalli Hills in influencing the physical geography of northwestern
India?

A.  A. They block monsoon winds and cause heavy rainfall in
Rajasthan.

B.  D. They act as a barrier preventing the eastward expansion of
the Thar Desert.

C.  B. They divide the Deccan Plateau into two parts.

D.  C. They form the boundary between India and Central Asia.

✓

Q32 GA
Which of the following does NOT belong to the four Vedas?

A.  C. Upanishads

B.  A. Aranyakas

C.  D. Brahmanas

D.  B. Netti Pakarana
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✓

Q33 GA
Which of the following is an example of a biotic interaction in an
ecosystem?

A.  D. Minerals dissolving in water

B.  A. Predation among animals

C.  C. Wind affecting plant growth

D.  B. Sunlight warming the soil

✓

Q34 GA
Which of the following religions believes in the teachings of
Mahavira?

A.  C. Buddhism

B.  D. Islam

C.  B. Jainism

D.  A. Sikhism

✓

Q35 GA
Which of the following initiatives in India is most closely aligned with
the objectives of sustainable development?

A.  A. Expansion of coal-based energy to meet rising demand

B.  D. Intensive groundwater extraction for agricultural
productivity

C.  B. Expansion of fuel subsidies primarily for fiscal efficiency

D.  C. National Clean Air Programme for pollution reduction

✓

Q36 GA
What is the purpose of enrichment of ores in metallurgy?

A.  C. To convert ore into metal

B.  D. To increase the metal content chemically

C.  A. To change the chemical nature of metal

D.  B. To remove impurities from the ore

✓

Q37 GA
During free fall near the surface of the Earth (ignoring air
resistance), what is the nature of the acceleration of an object?

A.  B. Zero

B.  D. Variable

C.  C. Constant and equal to acceleration due to gravity

D.  A. Depends on mass

✓

Q38 GA
The Western system of musical instrument classification is derived
from which ancient Indian system?

A.  D. Vedic Samhitas grouping

B.  C. Arthashastra grouping

C.  B. Natya Shastra grouping

D.  A. Sangita Ratnakara grouping

✓

Q39 GA
Which factor most directly accelerates chemical weathering in
tropical regions?

A.  A. High temperature and heavy rainfall

B.  B. Strong wind currents and dry climate

C.  D. Low temperature and sparse vegetation

D.  C. Steep slopes and rapid river flow

✓

Q40 GA
Which of the following schemes was NOT merged into the PM VIKAS
initiative?

A.  A. Seekho Aur Kamao

B.  B. Nai Manzil

C.  C. Nai Roshni

D.  D. Nai Darshan
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the underlined group of words.

My father enquired about a(an) consultant for eye diseases.

A.  B. altruist

B.  C. scrounger

C.  A. oculist

D.  D. convalescent

✓

Q42 English
Choose the option that is the correct opposite of the underlined word.

The group of boys, quietly and without being noticed, plundered the houses in the village.

A.  A. ignored

B.  C. touched

C.  D. protected

D.  B. observed

✓

Q43 English
Identify the antonym of the highlighted word.
I am pondering whether or not I should join another committee.

A.  A. Contemplating

B.  C. Overlooking

C.  B. Reviewing

D.  D. Considering

✓

Q44 English
Complete the sentence by choosing the correct option.

When I met Rina last night, she .................. her assignment.

A.  C. worked on

B.  B. was working on

C.  A. had worked on

D.  D. had been working on

✓

Q45 English
Identify the correct sentence which is correctly written in direct speech.

A.  A. He said that, “I am tired.”

B.  B. He said, “I am tired.”

C.  D. He said that he is tired.

D.  C. He said to me that, “I am tired.”
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✓

Q46 English
Choose the correct meaning of the underlined idiom.

I have not mentioned any names yet, but if the cap fits, you should wear it.

A.  C. If you try hard, success will follow

B.  A. If you lose something, replace it soon

C.  B. If you like something, take it quickly

D.  D. If the remark applies to you, accept it

✓

Q47 English
Select the correct proverb that can substitute the underlined group of words in the given sentence.

After hearing the rumors, the principal warned students that (what you throw comes back to you).

A.  A. a bird in the hand is worth two in the bush

B.  B. as you sow, so shall you reap

C.  D. every cloud has a silver lining

D.  C. the last straw

✓

Q48 English
From the options given below, choose the sentence which is correctly written in active voice.

A.  B. The scientist discovered a new element last year.

B.  C. The scientist discovers a new element last year.

C.  A. The scientist discover a new element last year.

D.  D. The scientist discovering a new element last year.

✓

Q49 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(A) along with his college friends,/ (B) and their tents got flooded/ (C) ended early/ (D) Ronan's camping trip,/ (E) as there was a thunderstorm

A.  C. BDACE

B.  B. DACEB

C.  D. DECBA

D.  A. ACEDB

✓

Q50 English
Select the most appropriate option from the given alternatives to fill in the blank.
The cat jumped _____ the wall and disappeared into the bushes.

A.  A. for

B.  D. over

C.  B. in

D.  C. at

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q51 English

Read the following passage carefully and answer the questions that follow.
In India, energy comes from both renewable and non-renewable sources. Non-renewable sources such as coal, oil, and natural gas are widely
used but cause pollution and may run out in the future. Renewable sources like solar, wind, hydro, and biomass are cleaner and can be used for a
long time without being exhausted. India is working to increase the use of renewable energy to reduce pollution and protect the environment.
Solar and wind energy are growing rapidly due to government support and improved technology. Energy efficiency is also important, as it helps
reduce waste and save resources. The country is focusing on cleaner energy solutions such as electric vehicles and better power systems. These
steps can reduce carbon emissions and improve air quality. By using more renewable energy and improving efficiency, India aims to build a
sustainable future. Responsible use of energy by individuals and industries is also necessary to ensure long-term energy security and
environmental protection.

Which option gives the most complete summary?

A.  B. Energy use should increase without limits

B.  A. Clean energy and efficiency ensure a better future

C.  C. Only traditional fuels are important today

D.  D. Pollution is not linked to energy use

✓

Q52 English
Which energy source is renewable?

A.  B. Coal used in power plants

B.  A. Oil used in vehicles

C.  C. Natural gas from the earth

D.  D. Solar energy from sunlight

✓

Q53 English
What does “renewable” mean in the passage?

A.  B. Can be used again and again

B.  A. Cannot be replaced once used

C.  D. Found only in limited areas

D.  C. Used only in industries

✓

Q54 English
What theme does the passage give?

A.  B. Use only non-renewable sources

B.  A. Shift towards cleaner energy sources

C.  C. Stop using energy in daily life

D.  D. Depend only on traditional fuels

✓

Q55 English
What can be inferred about renewable energy?

A.  D. It is harmful to the environment

B.  C. It is limited and will finish soon

C.  B. It is cleaner and more sustainable

D.  A. It is more expensive in all cases
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✓

Q56 English
Fill in the blank with the most appropriate option.

He _______ the truth after much hesitation.

A.  D. confessed

B.  C. concealed

C.  B. said

D.  A. informed

✓

Q57 English
Rearrange the segments (labelled P, Q, R, S) by choosing the correct option to form a coherent and meaningful sentence.

P. each other understand difficult parts, and completed
Q. after the teacher explained the concept clearly in class,
R. their assignment on time with confidence and accuracy
S. the students practised the questions together, helped

A.  D. PRSQ

B.  C. QSPR

C.  B. QPSR

D.  A. SPQR

✓

Q58 English
Select the most appropriate option to fill in the blanks. If no article is required, select the option with ‘X’.

Please take ____ water bottle with you. It is _____ too hot and you might get ____ dehydrated.

A.  B. a; X; X

B.  C. X; a; X

C.  A. an; a; a

D.  D. X; X; a
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✓

Q59 English
Select the option that can be used as a one-word substitute for the underlined group of words.

She was showing deep religious feeling and is committed to helping the poor and the needy.

A.  A. devout

B.  C. apathetic

C.  D. sceptical

D.  B. indifferent

✓

Q60 English
Rectify the sentence by selecting the correct spelling from the options.
Experience has shown that human resource is the most valuable asset of any business. It is more valuable than capital or equipment.
Unfortunately, it is also the most wasted. People can be your biggest asset or your biggest liabilty.

A.  C. Liability

B.  A. Resourcs

C.  B. Equpment

D.  D. Aset

Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ଶବ୍ଦଗୁ ଡ଼ି କର ବି ପରୀତ ଶବ୍ଦ ଲେଖନ୍ତୁ
ସେ ଏକ "ଧନୀ" ବ୍ୟବସାୟୀ।

A.  A. ଗରି ବ

B.  B. ଭଲ

C.  D. ସୁ ନ୍ଦର

D.  C. ଶକ୍ତି ଶାଳୀ

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ସେ ଘରୁ  ବାହାରି ବା ଆଗରୁ  ଜଳପାନ ଗ୍ର ହଣ କରନ୍ତି  ।

A.  A. He takes breakfast before leaving home.

B.  C. He take breakfast before leave home.

C.  B. He taken breakfast before leaving house.

D.  D. He taking breakfast before to go.
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✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ରୋଜି  ତା ସ୍କୁଲ ରେ ଅଲ ରାଉଣ୍ଡର ପୁ ରସ୍କାର ପାଇଲା ।

A.  C. Rosy won the all-rounder award in her school.

B.  B. Rosy will win the all-rounder award in her school.

C.  A. Rosy is the all-rounder in her school.

D.  D. Rosy was the winner of the all-rounder award in her school.

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ଲତା ମଙ୍ଗେସ୍କରଙ୍କ ସୁ ମଧୁ ର କଣ୍ଠସ୍ଵର ର ଭଜନ ସମସ୍ତଙ୍କୁ  ମନ୍ତ୍ରମୁ ଗ୍ଧ କରି ଦି ଏ ।

A.  C. The melodious Bhajans of Lata Mangeshkar's voice enchant everyone.

B.  B. Lata Mangeshkar's melodious voice of Bhajans were very beautiful .

C.  A. Lata Mangeshkar's Bhajans are very soothing .

D.  D. Lata Mangeshkar's melodious voice enchants everyone.

✓

Q65 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
କୁ ହାଯାଏ "ନଈ କେ ବାଙ୍କ,ଦେଶ କେ ଫାଙ୍କ" । ସାଧାରଣତଃ ମୃ ତ୍ତି କାର କୋମଳ ଅଂଶ ଦେଇ ନଈ ଧାର
ଆଗେଇ ଚାଲେ । ଯେଉଁ  ପାର୍ଶ୍ଵ ରେ ମାଟି  ଯେତେ କୋହଳ ତାହା ସେହି  ଆଡ଼କୁ  ସେତେ ମୁ ହାଁ ଇ ଯାଏ । ତେଣୁ
ସେହି  ଆଡ଼କୁ  ବଙ୍କାହୋଇ ଆଗକୁ  ଯାଏ। ଏହି  କ୍ର ମରେ ପ୍ର ତ୍ୟେକ ନଦୀର ଗତି ପଥ ବକ୍ର  ହୋଇଥାଏ । ଅନ୍ୟ
ପକ୍ଷରେ 'ଫାଙ୍କ'ର ଅର୍ଥ  ହେଉଛି  ବି ଭି ନ୍ନ ରୀତି  ବା ବି ଶେଷ ରୀତି  । ତେଣୁ  ଦେଶକେ ଫାଙ୍କ'ର ଅର୍ଥ  - ପ୍ର ତ୍ୟେକ
ଦେଶର ଚଳଣି  ରୀତି  ହେଉଛି  ସ୍ଵତନ୍ତ୍ର । ତାହା ଅନ୍ୟ ଦେଶର ଚଳଣି  ଠାରୁ  ଭି ନ୍ନ । ଯେପରି କି  ; ଇଂଲଣ୍ଡରେ ବାସ
କରୁ ଥି ବା ଲୋକେ ଇଂରାଜୀକୁ  ରାଷ୍ଟ୍ରଭାଷା ରୂ ପେ ଗ୍ର ହଣ କଲାବେଳେ ପାକି ସ୍ଥାନର ଲୋକେ ଉର୍ଦ୍ଦୁ ଭାଷାକୁ
ନି ଜର କରି  ନେଇଛନ୍ତି  । ସେହି ପରି  ଆମ ଭାରତରେ ବି ବି ଧ ଭାଷା ପ୍ର ଚଳି ତ ଥି ବା ସତ୍ତ୍ୱେ 'ହି ନ୍ଦୀ' ରାଷ୍ଟ୍ରଭାଷାର
ମାନ୍ୟତା ଲାଭ କରି ଛି  । ଖାଦ୍ୟ, ପାନୀୟ ତଥା ପୋଷାକ ଓ ପର୍ବ ପର୍ବା ଣି  ପାଳନରେ ମଧ୍ୟ ତାରତମ୍ୟ ରହି ଛି  ।
ଏଥି ରୁ  ଜଣାଯାଏ, ମନୁ ଷ୍ୟରୁ  ମନୁ ଷ୍ୟ ଓ ଦେଶରୁ  ଦେଶ ମଧ୍ୟରେ ଚଳଣି  ତଥା ରୀତି ନୀତି ର ଭି ନ୍ନତା ନି ଶ୍ଚି ତ
ଭାବରେ ରହି ବ ହିଁ ରହି ବ। କି ନ୍ତୁ ସମ୍ପର୍କ  ସ୍ଥାପନ କରି ବାକୁ  ହେଲେ ତାଙ୍କ ରୀତି ନୀତି  ତଥା ପରି ସ୍ଥି ତି  ପ୍ର ତି
ଅସୂ ୟା ଭାବ ପୋଷଣ ନକରି  ନି ଜକୁ  ସାମି ଲ କରି ନେବା ହେଉଛି  ବୁ ଦ୍ଧି ମାନର କାମ ।

"ଫାଙ୍କ" ଶବ୍ଦର ଅର୍ଥ  କଣ ?

A.  A. ଖାଲି  ସ୍ଥାନ

B.  D. ବି ଭି ନ୍ନ ରୀତି  ବା ବି ଶେଷ ରୀତି

C.  C. ଏକମାତ୍ର  ପଦ୍ଧତି

D.  B. ଅନୁ ଶାସନ
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✓

Q66 Odia
ଅନ୍ୟ ଦେଶ ସହ ସମ୍ପର୍କ  ସ୍ଥାପନ ପାଇଁ  କଣ କରି ବା ଉଚି ତ ?

A.  D. ନି ଜ ରୀତି କୁ  ଜୋର କରି ବା

B.  B. ଅସୁ ୟା ଭାବ ପୋଷଣ କରି ବା

C.  C. ତାଙ୍କ ରୀତି ନୀତି କୁ  ଅସ୍ଵୀକାର କରି ବା

D.  A. ତାଙ୍କ ରୀତି ନୀତି କୁ  ସ୍ଵୀକାର କରି  ନି ଜକୁ  ସାମି ଲ କରି ବା

✓

Q67 Odia
ଭାରତ ବର୍ଷ ରେ କେଉଁ  ଭାଷା ରାଷ୍ଟ୍ରଭାଷାର ମାନ୍ୟତା ଲାଭ କରି ଛି  ବୋଲି  ଉଲ୍ଲେଖ ଅଛି  ?

A.  B. ଓଡି ଆ

B.  D. ଇଂରାଜୀ

C.  C. ଉର୍ଦ୍ଦୁ

D.  A. ହି ନ୍ଦୀ

✓

Q68 Odia
ଅନୁ ଚ୍ଛେଦ ଅନୁ ସାରେ ପ୍ର ତ୍ୟେକ ଦେଶର ଚଳଣି  କି ପରି  ?

A.  B. ସମାନ

B.  A. ଅସ୍ଥାୟୀ

C.  D. ସ୍ଵତନ୍ତ୍ର ଓ ଭି ନ୍ନ

D.  C. ଅନି ୟମି ତ

✓

Q69 Odia
ନଦୀର ଗତି ପଥ ବକ୍ର (ଅଙ୍କାବଙ୍କା) ହେବାର ପ୍ର ମୁ ଖ କାରଣ କଣ ?

A.  B. ପାଣି ର ଅଭାବ

B.  C. ପାହାଡର ଉପସ୍ଥି ତି

C.  A. ମୃ ତ୍ତି କାର କୋମଳତାର ଭି ନ୍ନତା

D.  D. ବାୟୁ ର ଚାପ

✓

Q70 Odia
କାଲି  ମୋତେ ଜ୍ଵର ହୋଇଥି ଲା , ତେଣୁ  ମୁଁ  ସ୍କୁଲକୁ  ଯାଇ ନ ଥି ଲି  ।ଏଥି ରେ ଥି ବା ଅବ୍ୟୟ ପଦଟି କୁ  ଚି ହ୍ନଟ କର ।

A.  A. ମୋତେ

B.  D. ହୋଇଥି ଲା

C.  C. ସ୍କୁଲକୁ

D.  B. ତେଣୁ

✓

Q71 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଏକ 'ତଦ୍ଭବ' ଶବ୍ଦର ଉଦାହରଣ?

A.  B. ଆକାଶ

B.  D. ପର୍ବ ତ

C.  A. ନଦୀ

D.  C. ଘି ଅ
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✓

Q72 Odia
ନି ମ୍ନୋ କ୍ତ ବାକ୍ୟଗୁ ଡି କ ମଧ୍ୟରୁ  ଶୁ ଦ୍ଧ ବାକ୍ୟଟି କୁ  ଚି ହ୍ନଟ କର।

A.  C. ଜନସେବକମାନେ ବନା ସମୟରେ ସାହସର ଡଙ୍ଗାରେ ସହି ତ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

B.  A. ସାହସର ଜନସେବକମାନେ ବନ୍ୟା ସମୟରେ ସହି ତ ଡଙ୍ଗାରେ ଯାଇ ଗାଁ ’ ଗଣ୍ଢାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

C.  D. ଜନସେବକମାନେ ବନ୍ୟା ସମୟରେ ସାହସର ସହି ତ ଡଙ୍ଗାରେ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ଚୁ ଡ଼ାଚାଉଳ ବାଣ୍ଟନ୍ତି  ।

D.  B. ଜନସେବକମାନେ ବନ୍ୟା ଡଙ୍ଗାରେ ସମୟରେ ସାହସର ଚୂ ଡ଼ାଚାଉଳ ସହି ତ ଯାଇ ଗାଁ ’ ଗଣ୍ଡାରେ ବାଣ୍ଟନ୍ତି  ।

✓

Q73 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ସମ୍ବୋଧନ ସୂ ଚକ ଅବ୍ୟୟ ନୁ ହେଁ  ।

A.  A. ହେ

B.  D. ଆରେ

C.  B. ଗୋ

D.  C. ଏବେ

✓

Q74 Odia
ଦୀପ ମି ଞ୍ଜି ମି ଞ୍ଜି  ଜଳୁ ଛି  ।- ରେଖାଙ୍କି ତ ପଦଟି  କେଉଁ  ପ୍ର କାର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  B. ବି ଧେୟ ବି ଶେଷଣ

B.  C. କ୍ରି  ୟା ବି ଶେଷଣ

C.  D. ବି ଶେଷଣର ବି ଶେଷଣ

D.  A. ଅବସ୍ଥାବାଚକ ବି ଶେଷଣ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ତଦ୍ଭବ ଶଦ୍ଦ କେଉଁ ଟି  ?

A.  C. ଆଚାର

B.  B. ଆଲମାରି

C.  A. କୋବି

D.  D. କୁ ଆଁ ରୀ
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Computer

✓

Q76 Computer
Which feature in MS Word helps to find a specific word or phrase
within a document?

A.  C. Review

B.  D. Find and Replace

C.  A. Word Count

D.  B. Spell Check

✓

Q77 Computer
Software responsible for running and managing applications is
known as

A.  C. System Software

B.  B. Application Software

C.  A. Programming Software

D.  D. Embedded Software

✓

Q78 Computer
Which shortcut key is used to save a PowerPoint presentation
quickly?

A.  D. Ctrl + N

B.  A. Ctrl + S

C.  C. Ctrl + O

D.  B. Ctrl + P

✓

Q79 Computer
In Normal view, to enter text into a slide you should:

A.  D. View → Slide Master → Insert Text

B.  B. Design → Text Entry

C.  A. File → Edit Text

D.  C. Insert → Text Box → draw box → type

✓

Q80 Computer
To have a background music audio clip play across all slides in your
presentation, you would:

A.  D. Insert → Audio → choose file, then Playback tab → Play
across slides

B.  C. Design → Background Music

C.  A. Slide Show → Loop Music

D.  B. Insert → Text Box → Type music

✓

Q81 Computer
In an e-mail, which part specifies the identity of the recipient?

A.  A. Subject line

B.  C. Header

C.  B. Body

D.  D. Signature

✓

Q82 Computer
What type of software is essential for the computer to start up,
manage hardware, and run all other programs, acting as the bridge
between the user and the machine's components?

A.  D. Application Software

B.  C. System Software

C.  B. Utility Software

D.  A. Entertainment Software

✓

Q83 Computer
You want to insert a new column between columns B and C without
overwriting existing data. What should you do first?

A.  B. Press Delete on Column C

B.  A. Select Column C and click 'Insert'

C.  C. Select Column B and click 'Insert'

D.  D. Select any cell in Column A and press Enter

✓

Q84 Computer
Which of the following functions is used in MS Excel 2019 to show
the current date?

A.  B. today()

B.  D. now()

C.  C. date()

D.  A. time()

✓

Q85 Computer
What does the body of an email typically contain?

A.  D. Only the recipient address

B.  A. Email attachments

C.  C. The text message and the signature

D.  B. Only the subject line
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✓

Q86 Computer
Which feature in MS Word helps create a list with symbols or
numbers?

A.  D. Text Effects

B.  A. Bullets and Numbering

C.  C. Mail Merge

D.  B. Track Changes

✓

Q87 Computer
In Microsoft Word 2019, what is the correct sequence to open an
existing document?

A.  D. File > Save

B.  A. File > New

C.  C. File > Open

D.  B. Home > Paste

✓

Q88 Computer
Which of the following summaries best captures the distinctions
between system and application software?

A.  B. System software includes programs that manage the
hardware resources of a computer, while application software
refers to tools used for specific tasks.

B.  D. System software consists of applications designed for end-
users, whereas application software handles the operating
system operations.

C.  C. System software is used for personal tasks such as word
processing and spreadsheets, whereas application software
manages the computer's operating system.

D.  A. System software refers to software used on mainframes,
while application software is exclusive to personal computers.

✓

Q89 Computer
What does the abbreviation BIOS stand for?

A.  B. Basic Input/Output System

B.  D. Basic In/Out System

C.  A. Basic Input/Output Services

D.  C. Basic In/Out Services

✓

Q90 Computer
If you enter 3 in the Places box and then type 2834 in a cell of an MS
Excel spreadsheet, what will be the result?

A.  B. 283400

B.  C. 002834

C.  A. 2834.00

D.  D. 2.834
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Reasoning

✓

Q91 Reasoning
Seven people, X, Y, Z, R, S, T and U are sitting in a row facing South. S
is sitting at one of the extreme ends. Z is sitting second to the right
of S. Only Y is sitting between X and Z. R is sitting to the immediate
left of T. Who is sitting second from the extreme right end?

A.  C. X

B.  B. R

C.  D. Z

D.  A. T

✓

Q92 Reasoning
In a certain code language,
‘A + B’ means ‘A is the mother of B’,
‘A − B’ means ‘A is the sister of B’,
‘A % B’ means ‘A is the wife of B’ and
‘A $ B’ means 'A is the brother of B’.
If ‘N + S − P % M $ K’, how is N related to K?2437

A.  B. Sister's husband's mother

B.  D. Brother's wife's mother

C.  A. Husband's mother

D.  C. Brother's mother

✓

Q93 Reasoning
Seven boxes, I, J, K, L, W, X and Y, are kept one over the other but not
necessarily in the same order. No box is kept above I. Only three
boxes are kept between I and Y. Only one box is kept between K and
J. J is kept immediately above Y. Only four boxes are kept between K
and W. X is kept at some place above L. Which box is kept second
below X?

A.  D. I

B.  A. K

C.  C. L

D.  B. Y

✓

Q94 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
EFN : AKS
WPX : SUC

A.  B. UKM : ROQ

B.  A. ZRX : UVB

C.  C. WAS : SEW

D.  D. OZH : KEM

✓

Q95 Reasoning
If 1 is added to each odd digit and 2 is subtracted from each even
digit in the number 8714356, how many digits will appear more than
once in the new number thus formed?

A.  C. None

B.  B. One

C.  A. Two

D.  D. Three

✓

Q96 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

MEH 7 PGG -14 SIF 28 VKE -56 ?

A.  C. MJU 231

B.  D. YMD 112

C.  A. GTR -111

D.  B. NHU -651

✓

Q97 Reasoning
In a certain code language, ‘urn olive egg’ is coded as 'gv nm nv' and
‘input urn news’ is coded as ‘nm vh hd’. How is ‘urn’ coded in that
language?

A.  D. vh

B.  C. nv

C.  A. nm

D.  B. gv

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-clusters are alike in a certain way and thus form a group.
Which is the letter-cluster that does NOT belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their positions in the letter-cluster.)799

A.  A. MXC

B.  B. NYD

C.  D. OZE

D.  C. PAS
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✓

Q99 Reasoning

Read the given statement(s) and conclusions
carefully. Assuming that the information given in
the statements is true, even if it appears to be at
variance with commonly known facts, decide
which of the given conclusions logically follow(s)
from the statement(s).

Statements:
All jars are cats.
All cats are mugs.

Conclusion (I) : Some mugs are cats.
Conclusion (II) : All jars are mugs.

A.  A. Both conclusions (I) and (II) follow

B.  C. Neither conclusion (I) nor (II) follows

C.  B. Only conclusion (II) follows

D.  D. Only conclusion (I) follows

✓

Q100 Reasoning
Refer to the following series and answer the question. (All numbers
are single-digit numbers only. Counting to be done from left to
right.)

(Left) 6 2 9 3 5 4 6 9 2 5 8 4 8 7 4 2 5 7 9 4 1 3 6 2 8 4 5 7 1 (Right)

How many such even digits are there each of which is immediately
preceded by an odd digit and also immediately followed by an even
digit?

A.  D. More than three

B.  B. One

C.  A. Two

D.  C. Three
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